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Disclaimer

� The information contained in this publication is provided for informational purposes only. While efforts were made to verify the 
completeness and accuracy of the information contained in this publication, it is provided AS IS without warranty of any kind, express 
or implied. In addition, this information is based on IBM’s current product plans and strategy, which are subject to change by IBM 
without notice. IBM shall not be responsible for any damages arising out of the use of, or otherwise related to, this publication or any 
other materials. Nothing contained in this publication is intended to, nor shall have the effect of, creating any warranties or 
representations from IBM or its suppliers or licensors, or altering the terms and conditions of the applicable license agreement 
governing the use of IBM software.

� References in this publication to IBM products, programs, or services do not imply that they will be available in all countries in which 
IBM operates. Product release dates and/or capabilities referenced in this presentation may change at any time at IBM’s sole 
discretion based on market opportunities or other factors, and are not intended to be a commitment to future product or feature 
availability in any way.  Nothing contained in these materials is intended to, nor shall have the effect of, stating or implying that any 
activities undertaken by you will result in any specific sales, revenue growth or other results. 

� All customer examples described are presented as illustrations of how those customers have used IBM products and the results they 
may have achieved.  Actual environmental costs and performance characteristics may vary by customer.

� IBM, the IBM logo, Lotus, Lotus Notes, Notes, Domino, DeveloperWorks and Workplace are trademarks of International Business 
Machines Corporation in the United States, other countries, or both.

� Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both

� All references to Renovations refer to a fictitious company and are used for illustration purposes only.

� Other company, product, or service names may be trademarks or service marks of others.
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� Workflow for XPages
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XPages Extension Library OpenNTF

� Available at http://extlib.openntf.org/ 

– Active conversation with developers in the Discussions and Defects section 
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XPages Extension Library OpenNTF

� There are 2 sets of plugins included in OpenNTF delivery 

– “extlib” and “extlibx”. 

� Each set is wrapped into its own XPages specific library

– com.ibm.xsp.extlib.library

– com.ibm.xsp.extlibx.library

� The “extlibx” library contains eXperimental code 

– RDBMS support

– Social Enabler  and others 

� Experimental code can get added to the “extlib” library

– once the code has matured and there is sufficient customer demand
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XPages Extension Library OpenNTF

� XPages apps can depend on both the extlib and extlibx libraries

– RDBMS access requires both dependencies
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XPages Extension Library Demo App

�       XPagesJDBC.nsf 

– SQL table data and sorting

– SQL query data

– SQL query with count and page navigation

– SQL query data when query is in a file

– SQL parameterized query

DEMO
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New XPages Data Sources for RDBMS

� XPages leverages JDBC when connecting to relational databases

– Accesses any database with a JDBC driver available

– You could access 

•  DB2,

•  Oracle,

•  MS SQL,

•  MySQL,

•  Derby

• ... you name it!

– You need to obtain the JDBC driver from the database vendor or third party provider

� RDBMS data is accessed directly – no synchronization is performed with NSF

� XPages efficiently manages the connections through a connections pool

� Uses NSF specific connections

� The data is accessed using a set of dedicated data sources
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New XPages Data Sources for RDBMS

� extlibx library adds 2 new data sources:

– JDBC Query for Read Only access

– JDBC RowSet for CRUD (create/read/update/delete) access. 

• Current implementation is based on com.sun.rowset.CachedRowSetImpl, 

• Could be configured to use your own via the rowSetJavaClass property

� Each of the provided new data 
sources could be easily utilized either 
by: 

– the core View Container Control 
(xp:viewPanel element) 

– the XPage itself (xp:view 
element)

� The new data sources are now 
available in the Domino Designer 
Property Panel
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New XPages Data Sources for RDBMS

� For both JDBC Query and JDBC RowSet data sources, access to fields in SQL data are: 

– via the core xp:viewColumn element 

– using its columnName property 

• i.e. the same way you do with Domino View data source

� Currently you need to know what RDBMS fields are returned in your specified SQL table or by a SQL query

� Code snippet showing the definition of a view column using the “firstName” RDBMS field

– The column can even be made sortable!
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New XPages Data Sources for RDBMS

� It's very easy to bring your relational data into an XPages enabled web application using familiar Domino Designer 
controls
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New XPages Data Sources for RDBMS

� For the CRUD scenario – you could easily develop a record editing dialog, taking values from the JDBC RowSet 
data source
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XPages Extension Library Demo App

� DEMO of the Domino Designer view control configuration, with the new JDBC data sources:

– JDBC Query usage

– JDBC RowSet usage
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Making RDBMS Connections

� To connect to your RDBMS you need to create a special file resource

– .jdbc extension (for example “db2test.jdbc”)

• Specifies the JDBC driver class to be used

• The database host/port/name and users' credentials

<jdbc>

<driver>com.ibm.db2.jcc.DB2Driver</driver>

<url>jdbc:db2://testvm:50000/SAMPLE</url>

<user>demo</user>

<password>test123</password>

</jdbc>

• The  file name before the “.jdbc” extension is the connection name (in this case “db2test”) 

– Should be used in the JDBC data sources configuration

� File resources with the “.jdbc” extension 

– Should be placed within an XPages application (NSF) 
under the WebContent/WEB-INF/jdbc folder

– This folder is visible within Domino Designer in the Navigator/Package Explorer views only. 

– It is not visible in the default Applications view

� File resources within the WebContent/WEB-INF 

– Cannot be accessed via URL syntax 

– Your password and connection data is secure
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Making RDBMS Connections

� SQL data can be made available by using the following properties:

– sqlTable (the runtime will generate a select * from <sqlTable> ) 

– sqlQuery (SQL query, which could be either static or computed)

– sqlFile (file resource with the “.sql” extension, containing the SQL statement)

� The Core Pager control (xp:pager) can be used to navigate through the SQL data and additional properties can help 
display the actual number of pages for the JDBC Query data source:

– calculateCount (false by default, but when set to true, the runtime will generate select count(*) for the 
corresponding table or query)

– sqlCountQuery (allows you to specify your own count query)

– sqlCountFile (file resources with the “.sql” extension, containing the SQL count query)

� For the JDBC RowSet data source, you could limit the number of rows retrieved by:

– maxRows (default is 0, all rows retrieved, so be careful here)

– Pager control is already aware of the actual number of pages

� File resources with the “.sql” extension should be placed in an XPages application, under the WebContent/WEB-
INF/jdbc folder.
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Making RDBMS Connections

� SQL query could be parameterized using the '?' syntax

– select * from users where state=?

� Each corresponding parameter can be defined using the sqlParameters data source property and this can also be 
computed
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Making RDBMS Connections

� For your SQL queries and DB2 RDBMS you can:

– Call User Defined Functions (UDF) using the special sysibm.dual table

– Refer query fields by using aliases
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Making RDBMS Connections

� The use of these various properties are demonstrated in the included XPagesJDBC.nsf demo application

� DEMO of the additional 
XPagesJDBC.nsf application 
capabilities:

– Programming aspects

– @Functions usage
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Server Side JavaScript APIs and @Functions

� Currently implemented @Functions:

– @JdbcInsert

– @JdbcUpdate

– @JdbcDelete

– @JdbcExecuteQuery

– @JdbcDbColumn

– @JdbcGetConnection

� Used to simplify various RDBMS 
operations

� Allows programmatic access to RDBMS data
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Server Side JavaScript APIs and @Functions

� @JdbcInsert function has now an additional calling prototype, which allows you to take advantage of the RDBMS 

table autoincrement/identity field:
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Server Side JavaScript APIs and @Functions

� @JdbcExecuteQuery can be used for quick RDBMS data retrieval and additional processing inside your XPage

� @JdbcDbColumn can be used to populate, for example, an XPages combobox control, with the RDBMS table fields' 

values
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Server Side JavaScript APIs and @Functions

� To access a row in the JDBC data source, inside an xp:viewPanel, you need: 

– an index variable specified via the indexVar property, for example, 'idx'

– usage of the data source getRow(int index) method, for example, #{javascript:jdbcData1.getRow

(idx)}, for some event processing

� Changes to the JDBC RowSet data source could be saved back to the RDBMS using:

– #{javascript:jdbcData1.acceptChanges()} syntax
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Setup of Server/Development Environments

� If you have Upgrade Pack 1 previously installed – you need to uninstall it

� To consume RDBMS data, you need to install the OpenNTF version of the XPages Extension Library,

� Since the OpenNTF version doesn't have an installer, like the UP1 installer, you need to follow these steps:

– Download the latest ExtensionLibraryOpenNTF-853-YYYYMMDD-HHMI.zip file (it's big!)

– Unzip that big zip updateSiteOpenNTF.zip file (to be installed on the Domino server/Notes preview server)

– Unzip all the content in the updateSiteOpenNTF.zip file, so you can access the site.xml, as well as the features/
plugins folders

– Unzip, from the big zip, the updateSiteOpenNTF-designer.zip file (to be installed in Domino Designer)

– No need to unzip the updateSiteOpenNTF-designer.zip content
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Setup of server/development environments

� Installation on the Domino server should be done using the XPages Extension Library Deployment in Domino 

8.5.3 and IBM XWork Server technique described in the Lotus Notes and Domino Application Development wiki:

– Involves creation of a new NSF application based on the updatesite.ntf template and import of the extracted 
updateSiteOpenNTF.zip content, using its site.xml file

– Requires specification of an OSGI_HTTP_DYNAMIC_BUNDLES variable inside your server's notes.ini file to 
point to the update sites' NSF

– Uses additional safeguards when loading plugins (ACL)

� Installation for Notes web preview (where no Domino server is running) should be done based on the Using an 
XPages Library in Designer technique, which is also described in the Lotus Notes and Domino Application 
Development wiki:

– Requires the features/plugins folder content, which was previously extracted from updateSiteOpenNTF.zip, to 
be merged with the existing features/plugins folders found under the <Notes_Data>\domino\workspace
\applications\eclipse folder

– Special attention should be taken not to use, for Notes web preview purpose, another similar looking folder 
<Notes_Data>\workspace\applications\eclipse, whose purpose is to provide features/plugins for the Notes 
client/Domino Designer functionality
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Setup of server/development environments

� In order for the Domino server to load these installed plugins, you need to restart your Domino server, issuing the 
console command restart task http

� To verify the plugins for the extlib and extlibx XPages libraries are properly installed - you should use the OSGI 
command on the server console:
tell http osgi ss com.ibm.xsp.extlib
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Setup of server/development environments

� An additional plugin/update site, which wraps the JDBC driver, is required for the installation to connect to a particular 
RDBMS

– a sample update site for the DB2 JDBC driver is available 
on the OpenNTF web site for demonstration. Verification 
on the server, is via the command:
tell http osgi ss extlib.driver.db2

– you could manually customize a 
similar JDBC drivers' plugin/update 
site in the Eclipse IDE, using the 
extension point 
com.ibm.commons.Extension and 
a service type of 
com.ibm.common.jdbcprovider

– Your Java class should instantiate the 
required JDBC driver 
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Setup of server/development environments

� Domino Designer requires the Enable Eclipse plug-in install preference to be enabled for the    File → Application 
→ Install menu    to appear, so that the update site can be manually installated

� You need to point Domino Designer to the 
location of updateSiteOpenNTF-designer.zip 
which was previously extracted from the big 
OpenNTF zip file
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Setup of server/development environments

� The Domino Designer update site installation process displays the features which are available in selected update 
site

� One of these features is related to extlibx library functionality, which contains Relational support

� During further steps you'll need to confirm, several times, that you'd like to install the unsigned features
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Setup of server/development environments

� Verification of the correct installation within Domino Designer:

– Select Help → About IBM Lotus Domino Designer menu

– Click Plug-in Details button, sort by Plug-in Id and scroll to the extlib/extlibx plugins
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Future Directions for RDBMS Support

� XPages  Extension Library OpenNTF and Relational support continues to evolve  further and expected features in 
the pipeline include:

– Global Domino server based RDBMS connection definition ability

– Better Domino Designer tooling to work with the RDBMS tables' metadata

– Even better JDBC connection pooling implementation using Apache DBCP

– JDBC Query possibility via REST services

– Additional @Functions you are missing for your next great XPages application ;-)
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Agenda

� Access to relational Databases from XPages

� JDBC Driver to access NSFs

� Domino REST APIs

� Workflow for XPages

� OSGi Tasklet Service
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Domino JDBC Access

� Currently a preview technology delivered on openNTF

– http://bit.ly/xn9PF1 

� Expose Domino data to external applications

– Allow data analytics on top of Domino data

– Fully support the Notes/Domino security model – Use the Internet user/password

– Connect from any application that supports JDBC connectivity

� Augment the Domino query capability with a new SQL engine working on top of the Domino data (views)

– Use SQL for dynamic queries, including custom selection, aggregation operators...
• Supports very complex queries on top of Domino data

– Dynamically re-sort view entries without creating an index

– Join data between multiple views, even coming from different databases/servers

– Aggregate data from different views/databases/servers

– Bring all the power of SQL to Domino data :-)

– Make it easy to consume from an XPages application
• Tightly integrated with the XPages Extension Library RDBMS extension

• Execute queries with the rights of the XPages user (a.k.a “Web User”)
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DomSQL in a Nutshell

� Gives read-only access to the data, by projecting the content of views as relational tables

� Exposes the Domino data through a JDBC interface

– Includes data and metadata access

� DomSQL is based on top of an award winning SQL engine: SQLite

– Very robust SQL engine used by many projects (http://www.sqlite.org/)

– Well known SQL grammar understood by many JDBC clients

� Multiple execution modes

– Executes within the HTTP process for XPages consumption
• Maximum performance, no network connection involved

– Executes within the DOTS process when accessed remotely
• Remote server implemented using RMI

� The engine is fully extensible, if needed

– The source code is provided under the Apache license, and it is only using the “C” toolkit public API.
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Use it From XPages with the Extension Library

Relational data 

definition

JDBC Connection

(Extension Library)

Any XPages Control that can bind to data

(views...)

Relational Datasource

(Extension Library)
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Or From Any Third Party Application That Supports JDBC Connectivity

DBVizualizer

Birt Report Editor



37

Agenda

� Access to relational Databases from XPages

� JDBC Driver to access NSFs

� Domino REST APIs

� Workflow for XPages

� OSGi Tasklet Service



38  |    © 2012 IBM Corporation

Types of REST Services
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Domino Data Service Resources

■ Database collection – list of databases on a server

─ http://{host}/api/data

■ View/folder collection – list of views and folders in a database

─ http://{host}/{database}/api/data/collections

■ View entry collection – list of entries in a view (or folder)

─ http:{host}/{database}/api/data/collections/unid/{unid}

─ http:{host}/{database}/api/data/collections/name/{name or alias}

■ View entry – for updating a view (or folder) entry 

─ http:{host}/{database}/api/data/collections/unid/{unid}/unid/{unid}

─ http:{host}/{database}/api/data/collections/name/{name or alias}/unid/{unid}

■ Document collection – for creating new documents

─ http://{host}/{database}/api/data/documents

■ Document – for reading, updating and deleting existing documents

─ http://{host}/{database}/api/data/documents/unid/{unid}
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Enabling the data service is required

■ Data service is disabled by default.

■ Can be enabled for Server, Database (View and Document), and View

■ Administrator controls which servers run the data service:

Internet Site 
or Server 
Document

{
    "code":403,
    "text":"Forbidden",
    "message":"Database not allowed for Web Access"
}
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Enabling the data service for a database

■ Application developer controls Database access:

■ Application developer controls View access:

View
Advanced
Properties

Database
Advanced  
Properties
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RESTful Domino 

■ Domino REST Services can be accessed two ways

─From XPages using the REST Service control 

─As built-in service called Domino Access Services (DAS) 

■ Domino Access Services (DAS) is an extensible set of services

─Domino Data Service

─Mail Service (Planned)

─Calendar Service (Planned)

─Custom Services
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Objectives

� Promote a common Workflow capability across products

– Make it platform agnostic with drivers that encapsulate the platform differences

• Full based on top of Java/OSGi

– Come with a robust implementation dedicated to the Domino platform

– Allow the move to a more robust architecture, like Lombardi

� Increase the Domino Application Development capability by providing an easy to use Workflow capability

– Increase the value of Domino as an application development platform

– Better compete with Microsoft Sharepoint, and .NET

– Workflow is one of the Domino app dev selling point, so make it real!
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Design Goals

� Make the workflow engine easy to use and integrate for the simple cases

– Predefined Workflow templates

• Simple approval...

– Easy to parameterize

– Connects to the existing infrastructure (directory, ...)

• Built-in drivers

– Ready to go set of XPages controls/API

� Make the engine customizable for more complex cases

– Custom workflow templates

• Requires some custom Java/XPages custom development

� Developer can use similar API to access workflow data regardless of the workflow type

– A workflow context object exposes the current state of the workflow and allows actions to be triggered

� Ensure that nothing is “hard coded” but provided through pluggable services

– From an XPages standpoint, the services will be available through Complex types
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Workflow types

� Different types of workflows are available

– Ad hoc workflows, for simple, no administration workflows

• Defined as part of the forms, using simple components

– Similar to the Workflow sub form

• Changing a process means opening Domino Designer and editing an XPage component

• Actions are happening synchronously

– Managed Workflows

• Defined outside of the form, generally is external databases

• Actions are happening asynchronously, using a background router

� Workflow context abstraction

– The workflow is accessed the same way, regardless of the underlying implementation

� XPages common controls

– Comes with a set of ready to use controls (action bar, display history...), connected to the worklow context
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Architecture

XPage

Workflow 
Engine 
Adapter

People 
Adapter

Common Workflow API

Simple 
Workflow 
Engine

Lombadi 
BPM 

Connector

Lotus 
Connection 

Profile 
Connector

Social Profile 
Connector

Lotus 
Workflow 
Connector

....

Lotus 
Workflow 

Org 
Connector

...
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Demo app snapshot: manager list all employee's "End of Year Review"
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Agenda

� Access to relational Databases from XPages

� JDBC Driver to access NSFs

� Domino REST APIs

� Workflow for XPages

� OSGi Tasklet Service

– Introduction and technology overview

– Environment setup

– Creating, deploying & debugging tasklets



Introduction to OSGi™

� OSGi used to stand for Open Service Gateway Initiative but is now just a 
trademark used to define the specifications for a module system and service 
platform

� Component model: OSGi bundle

– Private classpath: each bundle has its own classloader

– Static resources

– Fine grained dependencies control via package import/export

� Many other capabilities available

– Easy deployment

– Hot installation and dynamic configuration

– Provisioning

– Lifecycle via Bundle activator

� Multiple open source implementations

– Eclipse equinox

– Apache felix, Knopflerfish, Karaf, Concierge…



Where is it used in IBM Lotus® Notes®/Domino®?

Notes Client 8.0

Domino Designer 8.5

Domino Server 8.5.2

Domino Server 8.5.3+

Notes Client UI rewrite

using Expeditor/RCP platform

Tight Mail integration

Extension points
Preferences, ISA

Notes Designer UI rewrite

as plugins running within 

same process as Notes Client

New Eclipse editor for Xpages

Java, CSS, LotusScript

OSGi integration within the 

HTTP task

Xpages runtime enhanced to 

run as OSGi plugins

Security, OSGi console, …
Extension points

Expand OSGi support to other 

Domino services
●Rest APIs
●Open Social Container
●XPages Extension Library
●Domino OSGi Tasklet Service
●Domino Servlet Container



Web Application Services

IBM Lotus Domino OSGi in HTTP architecture

Custom 
plugins

Domino 
Web 

Engine

(HTTP Task)

Bridge Services

●OSGi start/stop
●XPages 
Classloading
●OSGi Console
●Common logging
●Request 
dispatching
●Domino Context

Ajax 
Proxy 
Servlet

XPages Plugins 
Runtime

JNI

Java™ Runtime Environment

OSGi™ / RCP Framework

Policy 
Servlet

Rest 
APIs

Equinox HTTP 
Service

Expeditor Web 
Container

Domino OSGi Core Services
Logging, Security, HTTP request Context

XPages 
Extension 
Library



IBM Lotus Domino OSGi Tasklet Service architecture

Tasklet 
Plugin

Domino 
OSGi

 Tasklet 
Service

(DOTS)

Bridge Services

●OSGi start/stop
●Message Queue
●OSGi Console
●Common logging
●Profile support

Tasklet 
Plugin

JNI

Java™ Runtime Environment

OSGi™ / RCP Framework

Tasklet 
Plugin

Tasklet 
Plugin

DOTS Core Service
Logging, Profile, Security

Service Thread
Manual

Service Thread
Scheduled

Service Thread
Triggered



Multiple deployments

� File based

– Bundles are packaged as jars or directories and dropped into the server file system

– Recommended location is {DominoData}/domino/workspace/applications

– Bundles execute with maximum security privileges

� NSF Based

– Bundles are imported into a database using the UpdateSite.ntf template

– Server is configured to use the updateSite database (notes.ini variable for HTTP, Profile for DOTS)

– Documents containing the bundles must be signed with privileged user id to load, after which bundles execute 
with maximum security privileges

� PDE tool: Developer configuration

– Server is instrumented to run bundles directly from eclipse workspace: deployment-less

– No need to export bundles every time a change is made

– Bundle are not physically installed making it easy to switch between configurations
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Prerequisites

� IBM Lotus Domino Server, 8.5.2+
– http://www.ibm.com/developerworks/downloads/ls/lsds

� Eclipse, 3.6.2+
– http://www.eclipse.org/downloads

� IBM Lotus Domino Debug Plugin (PDE tool)

– http://www.openntf.org/internal/home.nsf/release.xsp?
documentId=CBF874E9C4607B4C8625799D00287B8C

� OSGi Tasklet Service for IBM Lotus Domino, 2.0.3+
– http://www.openntf.org/internal/home.nsf/release.xsp?databaseName=CN=NotesOSS2/

O=NotesOSS!!Projects/
pmt.nsf&documentId=84018B5D35E44E2F8625795E00140D3A&action=openDocument

� XPages Extension Library
– Domino 8.5.3 Upgrade Pack 1

– or http://www.openntf.org/internal/home.nsf/release.xsp?databaseName=CN=NotesOSS2/
O=NotesOSS!!Projects/
pmt.nsf&documentId=2E25B5DA1BDFB9B48625794D005B0821&action=openDocument
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Environment setup for DOTS

� Installing DOTS

– Required Eclipse plug-ins and DOTS core files

� PDE Tool

– The version installed during the HTTP environment setup will persist across workspaces so there is no action 
needed.  On a clean setup you would follow the steps previous demonstrated in the HTTP environment 
setup.

� Target Platform

– DOTS is just another OSGi setup so it's almost the same as the HTTP setup with a few minor differences.

� Notes.jar

– This plug-in is just used for development and will be exactly the same as the version in the HTTP 
environment.  Simply import from the other workspace. On a clean setup you would follow the steps previous 
demonstrated in the HTTP environment setup.
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Installing DOTS (Required Eclipse plug-ins)

� The OSGi framework is located in {DominoBin}/osgi-dots/rcp/eclipse

� The minimum required set of plug-ins is comprised of the following list:

–  org.eclipse.core.contenttype

–  org.eclipse.core.jobs

–  org.eclipse.core.runtime.compatibility.auth

–  org.eclipse.core.runtime

–  org.eclipse.equinox.app

–  org.eclipse.equinox.common

–  org.eclipse.equinox.preferences

–  org.eclipse.equinox.registry

–  org.eclipse.osgi 

–  org.eclipse.update.configurator

� You should be able to simply copy these 10 plug-ins into the {DominoBin}/osgi-
dots/rcp/eclipse/plugins directory from any installed version of the Eclipse 
SDK.
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Installing DOTS (DOTS core files)

� Download the OSGI Tasklet Service for IBM Lotus Domino from OpenNTF

� The following files must be installed in the {DominoBin} directory

–  ndots.exe (Windows)

–  dots, dots.res (UNIX)

� The following files must be installed in the {DominoBin}/osgi-dots directory

–  launcher.jar

–  dotssec.jar

� The following files must be installed in the {DominoBin}/osgi-dots/shared/
eclipse/plugins directory

–  com.ibm.dots_2.0.3.XXXX.jar

–  com.ibm.dots.samples_2.0.3.XXXX.jar (optional)
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Environment setup for DOTS (PDE tool recap)

� An easy verification that the PDE Tool is installed is to check the OSGi Frameworks available to Eclipse

� You should see 3 frameworks

– Domino OSGi Framework

– Domino tasklet Framework (dots)

– Equinox
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Environment setup for DOTS (Target Platform recap)

� Add the {DominoBin}\osgi-dots\rcp\eclipse directory and click the Finish button

� Repeat the process to add the {DominoBin}\osgi-dots\shared\eclipse directory
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Environment setup for DOTS (Target Platform recap)

� Select the new Target definition you just created and click the OK button
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Environment setup for DOTS (Notes.jar recap)

� Use the “Create Notes Java Api Project” option from the PDE tool



Creating DOTS tasklets

Tasklet 
Plugin

Domino 
OSGi

 Tasklet 
Service

(DOTS)

Bridge Services

●OSGi start/stop
●Message Queue
●OSGi Console
●Common logging
●Profile support

Tasklet 
Plugin

JNI

Java™ Runtime Environment

OSGi™ / RCP Framework

Tasklet 
Plugin

Tasklet 
Plugin

DOTS Core Service
Logging, Profile, Security
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Service Thread
Triggered
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Creating DOTS tasklets

� Create a new workspace plug-in

– File->New->Plug-in-Project
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Creating DOTS tasklets

� Project Name: com.ibm.ls2012.dots

– Select “an OSGi framework” radio button under the Target Platform section

– Click on the Next button

� On the Content screen change the name to DOTSDemo

– Click on the Finish button
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Creating DOTS tasklets

� Go to the Overview tab, under Extension / Extension Point Content and click on Extensions

� Click Yes on the Extensions pages hidden screen



68

Creating DOTS tasklets

� Go to the Extensions tab and click the Add button...
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Creating DOTS tasklets

� Deselect the “Show only extension points from the required plug-ins”

– Select the com.ibm.dots.task Extension Point

– Click on the Finish button

� On the New plug-in dependency screen, click the Yes button 
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Creating DOTS tasklets

� Go to the MANIFEST.MF tab and click on the error and fix the singleton
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Creating DOTS tasklets

� Right click on the com.ibm.ls2012.dots package and click New->Class
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Creating DOTS tasklets

� Create a new Java class named MyScheduledTask extending com.ibm.dots.task.AbstractServerTaskExt 
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Creating DOTS tasklets

� In the MyScheduledTask class add unimplemented methods
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Creating DOTS tasklets

� Resolving some of the warnings and errors displayed

– On the Dependencies tab of MANIFEST.MF add lotus.domino to the list of Imported Packages
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Creating DOTS tasklets

� Scheduling of the MyScheduledTask tasklet via plugin.xml
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Creating DOTS tasklets

� Scheduling of the MyScheduledTaskAnnotated tasklet via annotations

– Custom method using annotations

– Tasklet still needs to be registered in plugin.xml
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Creating DOTS tasklets

� MyManualTask tasklet with the final plugin.xml
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Deploying & debugging a DOTS tasklet

� Click on Run->Debug Configurations...
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Deploying & debugging a DOTS tasklet

� Create a new OSGi Framework
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Deploying & debugging a DOTS tasklet

Deselect all plug-ins 
from the Target 
Platform
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Deploying & debugging a DOTS tasklet

� Create a new Remote Java Application
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Deploying & debugging a DOTS tasklet
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Deploying & debugging a DOTS tasklet

� Click on the DOTS OSGi Configuration and then click the Debug button

– This launches the PDE Tool

– Select the appropriate Domino Binary & Data directories

– Keep the default Profile of DOTS

– Click on the OK Button

� If everything worked OK then you'll see a Success dialog

– Click on the OK button
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Deploying & debugging a DOTS tasklet

� Finally, time to run the tasklets and break into the debugger

� Enable debugging via notes.ini

– DOTS_DEBUGADDRESS=8001

– DOTS_DEBUGSUSPEND=y

� load dots on the server console

� Set a break point in your code

� Go back to Run->Debug Configurations...

– Select DOTS Remote Debugging under Remote Java Applications

– Click on the Debug button
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Deploying & debugging a DOTS tasklet

� Confirm the switch to the Debug Perspective by clicking the Yes button
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Deploying & debugging a DOTS tasklet

� Debug as required
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Deploying & debugging a DOTS tasklet

� Output examples
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Questions or Comments?
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